LEOcoin Proof of Stake (PoS)
wallet.

Installation guide for
Windows and Mac.



LEOcoin Proof of Stake (PoS) Wallet: Installation Guide
This is in 2 parts; Windows then Mac

For Windows users

Please note that LEOcoin-qgt, the PoS wallet, downloads and stores the entire history
of LEOcoin transactions. Depending on the speed of your computer and network
connection, the synchronization process can take from a few hours to several days.

1. If you already have a previous LEOcoin Wallet on your computer, then
please BACKUP YOUR WALLET before upgrading to the new version.
Click on the “File” Menu Tab and choose “Backup Wallet”.

2. Choose where you want your Wallet file to be saved (.dat) and give it a name.

3. Find out your System type, 64-bit or 32-bit.

4. Open control panel and choose the System option.

Control Panel » All Control Panel ltems > System

s Help

View basic information about your computer

Windows edition

Windows 10 Pro -- .
© 2013 Microsoft Corporation. All rights reserved. .. Wl

Systemn

ings

Processor: Intel(R) Core(TM) i7-4700HC CPU @ 2.40GHz 2.40 GHz
Installed memory (RAM):  16.0 GB (15.9 GB usable)
Systern type: B4-bit Operating System, x64-based processor

5. Download Win64 (or Win32) version

» Downloads v | O Search Do.
G Mame Date mccl\i;‘iecl Size

(& LEOcoin-2.0.0.0-winf4-setup.exe 27/06/2016 12:42 3112 KB
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6. Windows 10 security features might not allow the program to run.
Windows protected your PC

Windows SmartScreen prevented an unrecognized app from starting. Running this app might put

_::;:’i(;fzt risk. S E C U R |TY |

Microsoft are trying to
protect you from malicious
programs.

7. Click on More info to get the option to ‘Run anyway’. If you clicked on the Don’t
run button, because you

Windows protected your PC weren’t sure about it; then

Windows SmartScreen prevented an unrecognized app from starting. Running this app might put
your PC at risk.

you have to go back to
your Downloads folder and
double-click on the setup
program again.

App: LEOcoin-2.0.0.0-win64-setup.exe
Publisher: Unknown Publisher

8. Note that even if you choose the 64-bit Windows version it installs in Program
Files (x86)

Choose Install Location
Choose the folder in which to install LEQcoin-Qt. @

Setup will install LEOcoin-Qt in the following folder, To install in a different folder, dick Browse
and select another folder. Click Install to start the installation.

Destination Folder

| Browse...

Space required: 19.1MB
Space available: 153.9GB

LECcoin-0k

<Back || sl | | cancel
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9. Windows 10 prevents network access by default.

|
SECURITY !

ﬁ Windows Security Alert #

%
@ Windows Firewall has blocked some features of this app

Microsoft (and many anti-

Windows Firewall has blocked some features of LEOcoin-Qt (055 GUI dient for LEOcoin) an all virus programs) will
public and private networks.
. Marme: EQcoin-Qt (055 GUI dient for LEOcoin)

recommend that you don't

Publisher: LEOcoin connect unknown
programs to the internet.

Path: Ct\program files (x86)Yeocoineocoin-qt.exe

This app is trying to receive information directly from the Internet, possibly bypassing your

firewall Connecting on private
Allow LEOcoin-Qt (0SS GUI dient for LEOcoin) to communicate on these networks: networks on |y is the safest
[ Private networks, such as my home or work network . . .
option, which is the

[]Public networks, such as those in airports and coffee shops (not recommended default from Microsoft.
because these networks often have litthe or no security)

_ . Anti-virus programs may
What are the risks of allowing an app through a firewall?

Allow access || Cancel |

Click on Allow Access

10.0ONLY if you have encrypted your Wallet,
you will need to click on the new checkbox before the wallet starts staking.

Wallet

Stake: 0.00 LEO

Unconfirmed: 0.00 LEOD

Mumber of

transactions: e

Unladk Wallet for Staking only

11.This will appear

Stake minting enabled. If you attempt to send cains or change your password,
you will need to re-enable

[oc ]
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12.Click on the check box again and stake mining is disabled.
UNLESS you didn’t encrypt and lock your wallet, then PoS is running all the time.

e

@ Info *

Stake minting disabled.

13.Program location is C:\Program Files (x86)\LEOcoin
Program name does not include -64bit like previous version.

v A » ThisPC » O5(C) » Program Files (x86) » LEOcoin v | O Search LI
~

LEOcoin ) Mame Date medified Type Size

LEOcoin Wallet [5] COPYING bt Text Document 3KB
Map Maker 74| LEQcoin-0t website Internet Shortout 1KB
MetaGeek @ LEOcoin-gt.exe Application 9,540 KB
Microsoft Analysis Services [l readmet Text Document 2KB
Microsoft ASP.NET ® uninstall.exe Application 61 KB

Mirrnznft Heln Viewer

14.There is no attempt to remove old versions.
So it is entirely possible that a user’s shortcuts (made by the user not the install)
could point to the wrong version.
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15.1f you pinned the previous version to start menu
The previous version is in the start menu, not the version you should be using.
The new version is in the recent programs list on the left.

9, PAul Maskens

L used o
SQL Server Configuration Manager w a N a X g v a P gl 0% r

WinRAR > Word 2016 OneNote 2016 Excel 2016 Visio 2013 Publisher 2016 Outlook 2016 Flipboard

SQL Server Installation Center (64...

Py P3 3 & o)

PowerPoint
Project 2016 2016 Meozilla Firefox Snipping Tool Character Map

¥
S o
SOL Server Visual Studio
Management... 2012

LEOcoin Wallet

Notepad ++ (64bit)

Remove the pinned (old) program and pin the new one.

If you do that before uninstalling the old version (see below) then the
uninstall will not leave behind a broken link.

16.There could be two versions in control Panel Programs and Features

This is the old version 1.3.0
Icon is LEO Ltd

{3 LEOcoin LEO Ltd

(@) LEOcoin-Ot LEOcoin Project

< >
@ LEOQ Ltd Product version: 1.3.0 Support link:  http://www.leocoin.org
@ Help link:  http://www.leocoin.org

The latest version 2.0.0 has the LEOcoin icon, LEOcoin Project

(9 LEOcoin LEO Ltd
®LEOcoin-Ot LEOcoin Project
<
LEOcoin Project Product version:  02.00.00.00 Support link:  httpe/fwww.leocoin.org
Help link:  http://www.leccoin.org
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17.Uninstall old version.

Right click on LEOcoin LEO Ltd and choose uninstall.

i ; |
Uninstall L EOcoin .
Remove LECcoin from your computer, o LEOCOII’I

LEOcoin will be uninstalled from the following folder. Click Uninstall to start the uninstallation.

Uninstalling from: | C:\Program Files (x86)\L.EOYLEOcoin

i
t

Uninstall Cancel

Uninstallation Complete - |
Uninstall was completed successfully. LEOCOII"I

Completed

Delete file: C:\Program Files (x86)\LEOYLEQcoin}L EQcoin-qt-64bit.exe

Delete file: C:'\Program Files (x86)\LEOYEQcoinYicense. txt

Delete file: C:\Program Files (x88) \LEOYEOcointuninstall.exe

Delete on reboot: C:\Users\Paul\AppData'\Roaming\Microsoft\Windows\Start Menup. ..
Remove folder: C:\Program Files (x86)\LEQ\LECcoin,

Completed

NOTE at this point it’s still in the start menu, because there is a ‘Delete on

reboot’
But the

action pending.
link should cause an error now.

“  The item 'LEOcoin-gt-o4bit.exe’ that this shortcut refers to has

"_:' been changed or moved, so this shortcut will ne longer work

properly,

Do

you want to delete this shortcut?

Clicking on Yes will delete the shortcut immediately instead of waiting for a

reboot.
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If you have an old installation of the 1.0.0 wallet then you may find it won’t sync at
all, and you can’t use it to back up your wallet.

It is in a hidden folder “AppData\Roaming\LEOcoin” under your username.
So you need to change the options in Windows Explorer to see hidden items.

N 0 = | LEOcoin

[Tl Preview pane @] Extra large icons & Large icons &2 Medium icons l Group by » [ item check boxes IZ‘
B petails pane [ smail icons EE List i=2 Details [T Add columns ~ File name extensions
Navigation o 2= _ sort Hide selected  Options
e Bi= Tiles E= Content B

o7 i size atl commns to it 9] Hiaden tems

Once you can view hidden items you can cause all kinds of damage - be careful !

Here is the view of what’s in the folder. Copy that wallet.dat file to another folder,
or a memory stick and keep it safe.

<« e 4l > AppData » Roaming » LEOcoin
2 A Name Date modified Size
AppData [] peersdat
Local [ wallet.dat
Locallow [7 bIk00O1 dat
Roaming [ blkindexdat
LEOcoin =] debug.leg
[ lock
5] db.log
deleted

Happy Staking
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For Mac users
19.1f you already have a previous LEOcoin Wallet on your computer, then
please BACKUP YOUR WALLET before upgrading to the new version.

Click on the “File” Menu Tab and choose “Backup Wallet”. Then choose where you
want your Wallet file to be saved (.dat) and give it a name.

20.Download the MAC client

It is put in the Downloads folder, and automatically unzipped, and the zip file
is moved to the trash.

So all you are likely to see in your dock is this:

5
¥

21.0pen Finder

‘, | Finde
[ ] O
1 = ENERE:
Favorites Name
@) AirDrop ® LEOcoin-Qt
. & |mage.png.jpeg
All My Files
e y as image1-2.JPG
Y iCloud Drive = image1.JPG
™| Roaring around tl

?'7""1; Applications
5 image005.png

E Desktop Broken Sentence

|ﬂj Documents = GAM RECOGNITI

0 Downloads = Global Associate
[}

BCBABO35.JPG ¢

22.Check the applications folder to see if there is an old version

(@) iTunes

# Launchpad

B Mail

7. Maps

€ Messages
Microsoft Remote Desktop
B Mission Control
& Mist

| Notes

& Photo Booth

# Photos
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23.Click on the downloads folder, then drag LEOcoin- to the Applications folder

Modifying “Applications” requires an
I ' administrator name and password.

Authenticate S E C U R |TY |

Enter the administrator Name and Password.

Apple want to protect you

ece [ Appications from yourself, so you need
< B = I:::I ol | | 28 ~ | | %% ~ Q . .
= , _ to give the Administrator’s
Favorites @ iTunes

@ AirDrop @ Launchpad credentials to move the

® LEOcoin-Qt
E AlMyFiles & Mail
) iCloud Drive 2 Maps
) Messages
¥ Applications E Microsoft Remote Desktop

And there it is, done.

24.Now if you click on it to try to run it

SECURITY !
B
|socoiu oLl
::;b:m” e Apple don’t know us, we
g Ao Sec 1 Duateaues atom meretenos oL oui are not registered with
B omaor Somg pa clbovian pacanss 1 them, so the paranoia
kicks in.
It doesn’t work, because LEO is not So you have to override
registered with Apple as a developer. this by forcing it open, and

then giving the
Administrator’s credentials
to prove you know what
you’re doing.

25.Hold down CTRL and click instead

2 “LEQcoin-Qt” is from an unidentified
= developer. Are you sure you want to open it?
A Opening “LEOcoin-Qt" will always allow it to run on
this Mac.

Safari downloaded this file today at 16:39 from
leocein.org.

Yes, trust us, Open it.

~ You are overriding your security preferences to
— install an app from an unidentified developer. Type
H an administrator's name and password to allow
this.

Username: I| I

Password: | |

Cancel Modify Settings
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26.Then comes the next security question

Do you want the application "LEOcoin-
| Qt.app” to accept incoming network
n connections?

Clicking Deny may limit the application’s behavior.
This setting can be changed in the Firewall pane of
Security & Privacy preferences.

7 Deny Allow

The wallet won’t work unless you choose Allow.

27.And there it is

e0ce LEOcain - Wallet

(o) v weset 0-00 LEO

Wallet (out of sync) Recent transactions (out of sync)

Stake: 0.00 LEO
Unconfirmed:  0.00 LEO

Number of 0
transactions:

Unlock Wallet for Staking only

~1064040 block(s) remaining

SECURITY !

Apple recommend that
you don’t connect
unknown programs to the
internet.

In a mastery of
understatement “may limit
the application’s
behaviour” means the
wallet won’t work without

28.1f your Wallet is encrypted, click on the check box to Unlock the Wallet for

Staking
® 00
Stake minting enabled. If you attempt to send
coins or change your password, you will need to
' re-enable
\_:\,/

There’s the confirmation dialog.
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29.Recommended options

Options

E Network  Window Display

Optional transaction fee per kB that helps make sure your transactions are
processed quickly. Most transactions are 1 kB. Fee 0.01 recommended.

Pay transaction fee | 0.000000 2 [LEO
Start LEOcoin on system login
Detach databases at shutdown
OK Cancel Apply

Tick both of the check boxes, and then click OK.
30.Where did it go? How do | get it back?

If you close the Wallet window, the application is still running and available
on the dock.
But it doesn’t follow the usual Ul of reopening the window if you click on it.

Show / Hide

Send

Receive

Sign message...
Verify message...
Options...

Debug window
Options >
Show All Windows

Hide
Quit

Use CTRL and click, then click on Show/Hide and you get the window back.
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31.Finding the wallet

If you have an old installation of the 1.0.0 wallet then you may find it won’t sync at
all, and you can’t use it to back up your wallet.

On Mac OSX.

It’s in your user Library/Application Support/LEOcoin folder.
In Finder, press Cmd + Shift + G then type ~/Library/Application Support/LEOcoin

Here is the view of what’s in the folder. Copy that wallet.dat file to another folder,
or a memory stick and keep it safe.

< = me % b O a
E— » [E Desktop » [ Accounts » [ AddressBook » | blkooo1.dat
- » [ Documents » [ Address Book Plug-Ins » [ App Store [ blkindex.dat
@ AirDrop
» [ Downloads > [ Application Support » [ CallHistoryD8 » [ database
2 All My Files Library » [ Assistants » [ CallHistoryTransactions » db.log
& icloud Drive i Moviss > B Audio » [ CloudDocs » | debuglog
B Music » [ caches [ com.apple.sharedtilelist » peers.dat
2 Applications [ Pictures » [ Calendars * [ com.apple.TCC [ B wallet dat
5 Deskiop [ Public » [ ColorPickers » [ CrashReporter >
[ Colors » [ Dock
[ Documents [ com.apple nsurisessiond > [ LEGcain
© Downloads [19] compositions » [ Preview
[ Containers + [ Quick Look .
Devices [ Cookies » [ skype

Happy Staking
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